Chapter IV.
Monitoring Tickers in Real-Time
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When you have completed setting up the Real-Time Alerts application,
you are ready to start monitoring your list of tickers.

1. Charting your tickers

B To begin monitoring your tickers in real-time, do as follows:

Be sure your PC is connected to the internet.

* Open the Real-Time Alerts application:

 Select the Alerts button from the TradingExpert Pro Quick
Launch Menu, or select Alerts from the TradingExpert Pro
Program menu.

* There are two ways to display charts of the list of tickers you are
tracking in real-time:

* Select tickers manually from the list in the left hand panel.
- Or -

» Activate the Auto Cycle feature which automatically cycles
through the list of tickers in sequence. Each ticker is
Q displayed for a specified length of time called the Refiresh
Rate.

» 7o activate continuous cycling of the charted tickers:

Auto Cycle toolbar button * From the Tickers command on the menu bar select Auto Cycle

Charts.
- Or -
* Click on the Auto Cycle Charts toolbar button.

B To specify the refresh rate (rate at which tickers are cycled):

Note * From the View menu, select Set Refresh Rate.

The information shown at the -or-

top of the Chart window (date, ~ « Click on the Refresh Ticker toolbar button.
time, close, high, low, and
open) pertains to the current
position of the vertical cursor
line. To check prices for a
particular bar, move the
cursor to that bar using the
scroll button or the arrrows on
the scroll bar at the bottom of
the window.

* The Refresh Display dialog box will appear.
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Time scale buttons found on toolbar

Refresh Display B3 |

Set the rate at which the tickers are refrezhed.

(] I Cancel

+ Use the up/down arrows on the list box to change the rate at which
tickers are refreshed.

* Click OK to confirm your change.

2. Changing chart time scale

The row of buttons at the right end of the Alerts window toolbar are
used to control the time period represented by each bar on the chart.
Seven different time scales are provided. These buttons allow you to
quickly switch the chart display from one minute bars to 60 minute
bars or to daily or weekly bars with a single click of your mouse.

W| D |60|30|15| 5 | [RT[ 112

The last time scale button, the RT button, is used to display the real-
time bar period that is shown in the adjacent box. The up and down
arrows on this box are used to adjust the RT period to any number
between 1 and 60 minutes.

When charting intraday information using time bars that represent time
spans longer than one minute, the data from the current day will
usually not fill the entire chart. In this case, data from prior days is
used to completely fill the chart. For all time scales including the daily
and weekly time scales, today's data will dynamically update.
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Vertical Scales page of Properties
box
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3. Changing the chart price scale

You can choose the method used to determine the upper and lower
limits of the price (vertical) scale. In addition to the default method,
which simply uses the highest and lowest prices within the charted
period, three other methods are provided.

» 7o change the vertical scaling method.
1. Click the right mouse button to access the menu.

2. From the menu, select Vertical Scaling. The Properties screen that
appears provides four Price Plot scaling options.

Properties x|

Wertical Scales

— Price Plot Scaling Method

Wisible data minmax +

Full data mindmax

Ahove Below
Percent abovesbelow last close © I'I aa IEEI
High Lo
Fised " [1000 [
(] | Cancel | Spply

3. Choose one of the following four options:

¢ Visible data min/max - Scale upper and lower limits are the
highest and lowest prices (or trading band values) from the
data visible within the charted time period.

¢ Full data min/max - Same as above except the data is not
limited to data visible within the charted time period. The
high and low values are taken from the entire amount of data
that has been downloaded including any data not visible on
the chart. With this option, the scale remains fixed as you
scroll backwards or forwards in time.

¢ Percent above/below last close - Scale limits are computed
from the last closing price (value at right hand side of chart)
as a percentage of that value. The above and below




OHLC Chart

Candlestick, Chart
v Single Line Chart

Faint and Figure

percentages that you enter should be chosen carefully as some
data may go off the chart depending on the volatility of the
ticker.

¢ Fixed - With this option, the scale is fixed based on high and
low prices that you enter. Obviously, the prices that you enter
should be chosen carefully to insure that the data is displayed
in a meaningful way.

4. After completing your entries, click Apply to put your changes into
effect.

5. Click OK to close the Properties dialog box.

Logarithmic Price Scale

When working with real-time or historical charts (daily and weekly),
you can display logarithmic price scaling.

» To display logarithmic price scaling:

1. Open the Properties dialog box by right clicking on the chart and
selecting Properties from the pop-up menu. Or, select Chart
Properties from the File menu.

2. In the Options section of this box, check the box labeled
Logarithmic Scale.

3. Click Apply to immediately change the scale of the displayed chart
or click OK to close the Properties dialog box.

4. Changing the price plot display

The default format for displaying price on the chart is hi-lo vertical
bars. Price may also be displayed as candlesticks, as a single line
graph of closing price only, or as Point and figure.

» 7o change the price plot display, do as follows:

1. Click the right mouse button to access the menu.

2. Check one of the four options:
OHLC Chart - Price is displayed as vertical bars.
Candlestick Chart - Price is displayed in candlesticks format.
Single Line - Closing price is displayed as a single line.
Point and Figure - Price is displayed as rows of stacked boxes.

3. A check mark will appear on the option you have chosen and the
chart will immediately switch to your selection.
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Point and Figure charts

Point and Figure charts can display real time, end of day, or weekly
price data. For detailed information on Point and Figure charts, see
chapter I of the Technical Indicators Reference Manual.

C: 2681 H: 2796 L: 2521

Point & Figure Chart of PKZ | « | - b

When a Point and Figure chart is displayed in Real-Time Alerts, the
following special conditions apply:

1. Alerts do not fire on Point and Figure chart data or any of the
indicators shown with Point and Figure charts. Alerts will still be
processed on the underlying OHLC data. There are no Point and
Figure trendline crossovers or Point and Figure breakouts.

2. Each column of the Point and Figure chart has a “virtual” open, high,
low, close. Ifthe column is an X (going up) column, the open and
low are at the bottom, high and close at top. The opposite is true for
down going (O) columns. Indicators are generated using these
‘virtual”’ OHLC numbers.

3. Trendlines can only be drawn horizontally or at 45 degrees from
horizontal. No other drawing figures are available.

A special Properties dialog box is used to change the scaling
parameters that determine how P&F charts are constructed. The box
allows separate settings for end of day and for intraday P&F charts.
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» 7o change Point and Figure scaling parameters, do as
follows:

1. To open the Properties dialog box, click the Point and Figure
Properties dialog box button on the toolbar. The Properties dialog
box will appear on your screen.

Point & Figure Properties dialog box

2. The dialog box is divided into two sections: End of Day and Intra-
day. In each section make the following entries:

e Box Size, select one of the following options:
* Traditional (End of Day only) - This option automatically
sets the box size depending on the price range of the

charted security. To see a table that lists the default box
size for 10 different price ranges, press the Details button.

* Fixed Box Size - Enter a box size value expressed in points
in the adjacent box.

* Fixed # of Rows - Enter a specific number of rows in the
adjacent box.

e Reversal - Enter a value expressed in number of boxes in the
box.

3. Click Apply to see the effect of your changes or click OK to close
the dialog box.
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Notes - Point and Figure charts

There are conditions under which the Point and Figure chart may, on
its own, alter the scaling parameters. For example, if you draw an end-
of-day chart of Berkshire Hathaway (stock price over $90,000) using a
box size of 0.01, there would be hundreds of thousands of boxes. In
such a case, the scaling will be changed to reduce the number of boxes
to a reasonable number.

When a Point and Figure chart is drawn, the more horizontal bands
(rows of boxes) the smaller the X and O icons become. There is of
course a lower limit to the size of the characters that can be shown on
the screen. If the Xs and Os become smaller than 5 pixels, a vertical
bar will appear.



5. Using the Overlay Feature

The Overlay feature enables you to display Price Plots of two tickers
simultaneously on the same chart. An overlay plot can be added to
both real-time and end-of-day charts.

» To add an overlay ticker to the current chart:

% 1. Click the rightmost toolbar button (4dd Overlay Ticker) to open the
Add Overlay Ticker dialog box.

Add Overlay x|

Ticker Symbal:
I

Enter only a single ticker.

(] I Cancel

Add Overlay Ticker dialog box

2. In box labeled Ticker Symbol, enter the symbol for the overlay
ticker you wish to display.

3. Click OK. An overlay chart will be drawn in the colors that are

specified for overlays in the Chart Colors section of the Properties
dialog box.

Chart of AMAT with QQQ overlayed
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Edit Price Data screen
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4. To remove the overlay ticker from the chart, click the second from

right button on toolbar (Remove Overlay Ticker).

6. Removing bad data values

While viewing a chart, you can easily change incorrect OHLC price
and volume data values with a command available on the chart window
right-click menu.

» 7o change bad data values:

1.

Edit Price Data For Ticker MLS

With a chart displayed, right-click in the chart window. From the
menu, choose Edit Data to display the Edit Price Data for Ticker ...
screen.

. The Edit Price Data screen lists price and volume data values for the

displayed ticker. For real-time charts, data values are listed by
minute. For end of day or end of week charts, data values are listed
by day. To change any of the five values listed for a particular time
or day:

¢ Click on the value you wish to change

¢ With the value highlighted, use the Delete key to clear the
data field.

¢ Type in a new data value

. When you have completed all your changes, click OK to close the

screen.

D ate | Open | High ‘ Low | Close | Yolume -~ ok
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Note

You can also use the Open
toolbar button to switch
between lists of tickers.

Note

When Cursor Bug is selected
on the Right Mouse Click
Menu, the exact location of
the cursor appears on the chart
window in the form of x,y
coordinates.

7. Switching between lists of tickers

You can easily switch between lists of tickers that have been saved as
Real-Time Alert files (extension .RTA). See section 1 of Chapter III
for instructions on saving lists as RTA files.

» To switch between lists of tickers:

1. Click the File command on the menu bar. The lower section of the
File menu lists a limited number of previously opened RTA files.
Click on a file name to open.

2. If file name does not appear on the File menu, select Open and use
the dialog box to find and open the file of your choice.

8. Drawing attributes on charts

Real-Time Alerts provides tools for drawing and editing trendlines and
placing arrows and text on charts. Tools are also provided that allow
you to define Fibonacci Studies, Gann Fans, and Regression lines on
charts. Drawing tools include:

* Cursor (for editing trendlines, text, and arrows)
* Zoom Tool

* Trendlines

* Regression Lines

 Parallel Lines

» Up and Down Arrows (for placing text and arrows on charts)
» Fibonacci Arcs

* Fibonacci Fans

» Fibonacci Retracements

» Fibonacci Time Zones

» Gann Fans (up and down)

» To access tools for drawing attributes on the Price Plot or on
an indicator plot, do the following:

While working in Real-Time Alerts, do one of the following:

1. Choose the icon for the tool you need from the Drawing Tools
Toolbar.

2. Click the Draw command on the menu bar, then choose a tool from
the menu.
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Chart window with trendlines.
Note trendline drawing icon
in upper left corner.
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3. Click anywhere on a chart with the right mouse button to display the
Right Mouse Click menu. Then select Draw Attributes and choose
the tool you want from the next menu.

Drawing trendlines and markers

To create new trendlines

» To draw trendlines on a Price Plot or on indicator plots, do
the following:
1. Select the drawing tool by clicking on the Trendline icon.

2. The trendline drawing icon appears in the upper left corner of the
chart.

3. Position the mouse cursor at the point the trendline is to begin.

4. Click and hold down the left mouse button, guide the mouse to the

end point of the trendline, then release the mouse button.

5. When you have finished drawing your trendline(s), cancel the
trendline cursor by one of the following methods:

¢ Click on the trendline icon to remove it from the upper left
corner of the chart.

¢ Click the cursor (arrow) drawing toll icon.

ADL - AMERICA OHNLINE INC
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To edit or delete an existing trendline:
» To edit a trendline:
You can edit a trendline in one of these two ways:

 Select the trendline that you want to edit by clicking anywhere on it
with the arrow. The Edit Trendline dialog box will appear. Notice

that this dialog box lists the Start and End Date, Time, and Price
Up Marker coordinates for the selected trendline. A Delete button is also
Diowar b arkeer provided which may be used to remove the selected trendline.
Edit Trendline |
— Start —End

[rate IEIAUMIEIEI
Time IH:EIEI Time I'IE:EIEI
Frice IE'I.D'IEEEE Price |54.SE43?5

Ok I Cancel |

Edit Trendline dialog box

* To modify the trendline, change any of the Start or End
coordinate data values by clicking on the data value you wish
to change and entering new data.

* When finished, click OK or, to delete the trendline, click the
Delete command.

» The second way to edit a trendline: Use the Edit Attributes function
(Right Mouse Click menu) to find and select the trendline that you
want to edit or delete. See Using Edit Attributes function for more
information.
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Chart window with trendlines
and markers
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To add up/down marker arrows with text

Use arrows to mark specific events, etc. on a chart.

» To place an up or down arrow on a chart:

I.

From the Right Mouse Click menu, select Draw Attributes, then
choose Up Marker or Down Marker from the next menu.

. The marker drawing icon appears in the upper left corner.

3. Position the mouse cursor at the point where you want the marker to

appear on the chart and click the left mouse button.

. A dialog box titled Text appears. You can add text for the marker

that you are placing by typing it into the box labeled Enter text for
marker. When you finish, click OK. The marker and any associated
text will now appear on the chart.

. When finished drawing this type of marker, click on the marker icon

in the upper left corner of the chart.
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To edit or delete a marker

» 7o edit a marker:

You can edit a marker in one of two ways:

Select the marker arrow that you want to edit or delete by clicking on
it with the left mouse button. The Edit Marker dialog box will
appear. Notice that this dialog box lists the coordinates for the
selected marker and displays the associated text. A Delete button is
also provided.



Edit Marker dialog box

Edit Marker |

Frice IEE.D#EE?E

» To modify the location of the marker, change the coordinate
data values by clicking on the data value you wish to change

* When finished, click OK or, to delete the marker, click the

and entering new data.
Use the text box to modify the text for the marker.

Delete command.

» Use the Edit Attributes function (Right Mouse Click menu) to find
and select the marker that you want to edit or delete. See Using Edit
Attributes function for more information.

Drawing technical studies on charts

In addition to trendlines, Real-Time Alerts provides tools that can be
used to draw the following technical studies:

Regression Lines
Parallel Lines
Fibonacci Arcs
Fibonacci Fans
Fibonacci Retracements
Fibonacci Time Zones
Gann Fans Up

Gann Fans Down
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Attributes dialog box
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» To use the studies drawing tools:

1.

Select the drawing tool you want to use by clicking on the icon for
the tool in the drawing tools toolbar. The study drawing icon will
appear in the upper left corner of the chart.

. Use your mouse to locate the particular study you have chosen on the

chart. See Charts, Chapter 1V, in this manual for information on
creating and editing Fibonacci studies, Gann Fans, and Regression
Lines.

Using the Edit Attributes function

Use the Edit Attributes function to find and select the attribute that you
want to edit or delete. For editing, this function uses the same Edit
Trendline and Edit Marker dialog boxes discussed previously.

» To edit an attribute:

I.

From the Right Mouse Click menu, select Edit Attributes. The
Attributes dialog box is displayed.

Attributes x|

2| 04419702 08:25:00 @ 0.336 to 04/19/02 12:50:00 @ 0,661
------ 0441302 03:10:00 & 0.347 to 04/13/02 13:55:00 & 0.648

2 Delete | ok | Ceneel

2. To locate the trendline, marker, or other attribute you want to edit or

3.

delete, click on the plus sign inside the box that is located to the left
of the symbol for the charted ticker. All current attributes for the
chart will be displayed.

To edit an attribute:

¢ Select the attribute and click the Edit command. The Edit
(Attribute Name) dialog box that appears displays data values
that specify the particular chart attribute that you have
selected. For example, the Edit Gann Fan dialog box allows
you to revise the Pivot Point coordinates as well as providing
options for revising the Fan lines.



Edit Fibonacci Retraceme x|
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Edit Fibonacci Retracement Delete | ok | cancel |

dialog box

¢ Use the boxes on this dialog box to change the attribute's
position, size, etc.

¢ Click OK to close the Edit (Attribute Name) dialog box.
4. To delete the attribute, select the attribute and click Delete.
5. Click OK to close the Attributes dialog box.
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Zoom window showing enlarged
area of price plot
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9. Using the Zoom tool

The Zoom toolbar function opens a special window that displays an
enlarged view of a rectangular area within the chart window. This tool
allows you to easily view a magnified area of the Price Plot or an
indicator plot.

» 7o use the Zoom tool:

1. Select the Zoom tool by clicking on the Zoom toolbar icon. The
Zoom icon should appear in the upper left corner of the chart.

3. Use your mouse to define the area that you want to enlarge:

* Position the mouse cursor at one corner of the area that you
wish to zoom and press the left mouse button.

¢ While holding down the mouse button, drag the mouse
towards the opposite corner of the rectangle. As you drag the
mouse, an outline of the area that you are defining appears on
the screen in the form of a rectangle.

* When the outlined area matches the area you want to zoom,
release the mouse button.

4. When you release the mouse button, the Zoom window pops onto the
screen displaying a blown up view of the zoomed area.

5. Click Close to close the Zoom window.
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10. Displaying technical indicators on charts

The technical indicators that can be displayed on the Real-Time charts
are shown in the Control Panel. Both those indicators that can be
plotted on the Price Plot and those that are plotted below the Price Plot
are listed. Use the up/down arrows on the scroll bar in the Control
Panel to view all available indicators.

» To display indicators:
Simply click the indicator names in the Control Panel. For example,
with a chart displayed on your screen, do the following:

1. Click the 21 d ST MA from the group of Price Plot indicators and
the 21-day Short Term Moving Average will be displayed on the
Price Plot of the chart.

2. From the lower group of indicators, click DirMov, and the
Directional Movement indicator will be displayed in the lower
window of the chart.

3. To display a second indicator, simply click another indicator; for
example, MnyFlow. The Money Flow indicator will be displayed
above the Directional Movement indicator.

» To remove an indicator from display:
Click the name of the indicator on the Control Panel.

» To quickly rearrange the indicator list in the Control Panel:

1. Select the indicator you want to move up or down in the list by
clicking on it with your mouse and holding down the mouse button
until small up and down green arrows appear.

2. To move the selected indicator, continue holding down the mouse
button while you drag the indicator up or down to the position you
prefer.

3. When the indicator is in the correct position, release the mouse
button.
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Indicator plot with stepped lines
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Choose indicator graph type (stepped or smooth)

Indicator plots on charts can be displayed with stepped lines.

» 7o change indicator plots from smooth to stepped lines:

1. Open the Properties dialog box by right clicking on the chart and

selecting Properties from the pop-up menu. Or, select Chart
Properties from the File menu.

2. In the Options section of this box, check the box labeled Stepped
Lines.

Stochastic: 31.5433
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11. Printing charts

Real-Time Alerts provides four options for printing the chart displayed
in the chart window.

» 7o print a chart from the File menu:
1. Click File on the main menu to access the menu.
3. Select one of the following commands to print the chart.

¢ Single Page Print - Prints price plot and all displayed
indicators formatted to fit an 8.5 in. by 11 in. page.
Background color is changed to white.

® Multi-Page Print - Same as Single Page Print except number
of indicators shown on first page is limited to three. Any
additional indicators are printed on subsequent pages.

* Screen Print - Prints a true copy of the chart window portion
of the screen. Size is approximately the same as the screen
and colors are not changed.

* Screen Print - Fit to Page - Same as Screen Print except
chart is expanded in size to exactly fill page. Aspect ratio of
chart is not changed.

» To print a chart from the Right Mouse Click menu:
1. Right mouse click on the chart window to access the menu.

3. Click Print Setup to make any necessary changes to your printer
setup.

3. Click the Print command to print the chart. The chart is printed in
the Single Page Print format as described above.
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12. Real-Time Alerts shortcut keys

Ctrl + N
Ctrl+ O
Ctrl + +
Ctrl + -
F3

Fo

F7

F8

F9

F10

F11

File New

File Open

Increase Spacing

Decrease Spacing

Clear Alert List

View/Hide All

View/Hide Status Bar
View/Hide Ticker List
View/Hide Alert Grid
View/Hide Entire Control Panel
View/Hide Date/Price Panel



